
Seite 1

Fachbereich Wirtschaftswissenschaften

Einführung in freie
statistische Software

Christian Reinboth, Dipl.-Wi.Inf.(FH)

Sommersemester 2017

Bachelorstudiengang Betriebswirtschaftslehre

Sommersemester 2017

Christian Reinboth, Dipl.-Wi.Inf.(FH)



Seite 2

Fachbereich Wirtschaftswissenschaften

Agenda

– Einführung

– Motivation

– Freie Software

– PAST-Grundlagen

– Deskriptive Statistik

– Lagemaße

– Streuungsmaße

– Ausreißeridentifikation

– Korrelationskoeffizienten
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– Explorative Statistik

– Box-Plot

– Induktive Statistik

– Lineare Regression

– Was kann andere (freie) Software?

– Kleine Vorschau auf Statistik II
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Fachbereich Wirtschaftswissenschaften

Wichtiger Hinweis
…für alle, die diese Folien „nur“ lesen

– Dieser Foliensatz ergänzt die Vorlesung „Statistik“ im berufsbegleitenden 

Bachelor-Studiengang Betriebswirtschaftslehre an der Hochschule Harz

– Dieser Foliensatz beinhaltet Übungen und Software-Tutorials 

für den Umgang mit der statistischen Analysesoftware PAST 

– aber keine Wiederholung theoretischer Grundlagen

– Wer nach einer Einführung in die Grundlagen der Statistik sucht, 

sei deshalb auf den Hauptfoliensatz zu dieser Vorlesung verwiesen

Download des Hauptfoliensatzes unter: https://www.hs-harz.de/creinboth/lehre/
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https://www.hs-harz.de/creinboth/lehre/
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Warum eine gesonderte Software-Einführung?
(Nur weil wir nicht per Hand rechnen wollen?)
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– Praxisnah: In keinem Betrieb würde

eine lineare Regressionsanalyse

noch „per Hand“ durchgeführt

– Vorbereitung: Wer im Rahmen der

BA empirisch arbeiten möchte, wird

hierfür Software einsetzen müssen

Und warum freie Software?

– Eine einfache SPSS-Lizenz kostet 

1.168,00 EUR pro User und Jahr

– Freie Software ist ohne Kosten

in Studium und Beruf einsetzbar
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Was ist SPSS?
Statistical Package for Social Sciences

▪ SPSS ist eines der marktführenden Softwareprodukte für statistische Analysen in 

der Sozial- und Gesundheitswissenschaft sowie in der Markt- und Meinungsforschung

▪ Es wurde 1983 von SPSS Inc., einer Ausgründung der Stanford University, entwickelt

▪ Der Name wechselte mehrfach von „Statistical Package for Social Sciences“ über 

„Superior Performing Software System“ und „Predictive Analysis Software“ (PASW)

bis zu IBM SPSS STATISTICS seit der Übernahme von SPSS Inc. durch IBM in 2009
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www.ibm.com/software/de/analytics/spss/
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Empfehlenswerte freie Statistik-Software
(Kategorie: Allgemeine Datenanalyse)
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PAST (Windows, Mac)

- Paleontological Statistics Software 

Package for Education and Data Analysis 

(Universities of Copenhagen and Oslo)

http://folk.uio.no/ohammer/past/

PSPP (Windows, Mac, Linux)

- Open Source-“Nachbau“ von SPSS

- Identische Funktionen und Bedienung,

„Look & Feel“ ist sehr gut vergleichbar

https://www.gnu.org/software/pspp/

SSP (Windows, Mac)

- Smith's Statistical Package

- “Ein-Mann-Entwicklung” von Prof.

Gary Smith vom Pomona College

http://economics-files.pomona.edu/ 

GarySmith/StatSite/ssp.html
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Empfehlenswerte freie Statistik-Software
(Kategorie: Spezielle Anforderungen)
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JASP (Windows, Mac, Linux)

- Just Another Stats Program

- Bietet liquiden Output, der sich mit 

jedem Klick ändert (ideal für Lerner)

https://jasp-stats.org

SOFA (Windows, Mac, Linux)

- Statistics Open For All

- Bietet vielfältige Möglichkeiten der

grafischen Aufbereitung von Daten

http://www.sofastatistics.com

MacANOVA (Windows, Mac, Linux)

- Entwickelt an der Uni Minnesota

- Der Schwerpunkt der Software liegt

auf der Varianzanalyse (ANOVA)

http://www.stat.umn.edu/macanova/
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Unser zentraler Beispieldatensatz
(bereits aus der Hauptvorlesung bekannt)

Ausprägung abs. Häufigkeit rel. Häufigkeit in %

20 Jahre 3 0,12 12,00%

21 Jahre 2 0,08 8,00%

22 Jahre 1 0,04 4,00%

23 Jahre 3 0,12 12,00%

24 Jahre 13 0,52 52,00%

25 Jahre 2 0,08 8,00%

26 Jahre 0 0,00 0,00%

27 Jahre 1 0,04 4,00%

Σ 25 1,00 100,00%
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Wie bekommen wir diese 

Daten nun in PAST? 
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Eingabe von Daten in PAST
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Relevante Funktionen:

> File > New (Anlegen einer neuen Datei)

> File > Save as… (Speichern einer Datei)

> Show > Column attributes (Namen, Skalen)
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Wo befinden wir uns?
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deskriptiv explorativ

induktiv

Statistik

LagemaßeStreuungsmaße

Ausreißersuche

B-P-K

T-Test

Chi²-Test

K-S-A

Kendall

Spearman

Tabellen
Box-Plot

Histogramm

Streudiagramm

Regression

Ausreißeranalyse
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Lagemaße und Streuungsmaße

Was ist hier was?

N = Anzahl der Werte

Min = kleinster Wert

Max = größter Wert

Mean = arithmetisches Mittel

Geom. mean = Geometrisches Mittel

25 prcentil = Unteres Perzentil

Median = Mittleres Perzentil

75 prcentil = Oberes Perzentil

Variance = Varianz

Stand dev. = Standardabweichung
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> Univariate > Summary statistics
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Das „SPSS-Analyseproblem“

– Software führt JEDE Analyse unabhängig von den Voraussetzungen durch!

– ...also auch die Berechnung des arithmetischen Mittels

– ... aus Schulnoten

– ... aus Geschlechtern

– ... aus Kontonummern

– ... aus Telefonnummern

– ... aus Präferenzrängen

– Bei komplexen Verfahren sind noch weit schlimmere „Vergehen“ denkbar

– Die fachlichen Kenntnisse der Anwender/innen sind daher entscheidend

– Darum: KEINE Analyse ohne vorherige Prüfung der Voraussetzungen!
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Warum ergeben sich andere Streuungsmaße?

– In der Vorlesung haben wir die 

Standardvarianz als Durchschnitt der 

quadrierten Abweichungen berechnet:

– s² = 2,8416 | s = 1,6875

– Mit Hilfe von PAST berechnen wir 

die sog. Stichprobenvarianz mit den

Freiheitsgraden (n-1) im Vorfaktor:

– s² = 2,96 | s = 1,72
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große oder eher für kleine 

Datensätze relevant?
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Fachbereich Wirtschaftswissenschaften

Gibt es einen Modus?
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> Plot > Histogram
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Fachbereich Wirtschaftswissenschaften

Folgt die Verteilung einer Normalverteilung?
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> Plot > Histogram
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Lässt sich die Grafik noch individualisieren? 
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> Plot > Histogram > Graph settings
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Bivariater Datensatz für Korrelationsanalysen
(ebenfalls aus der Hauptvorlesung bekannt)
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Befragte/r Größe (m) Gewicht (kg)

1 1,55 64

2 1,68 72

3 1,72 71

4 1,73 75

5 1,82 102

6 1,81 98

7 1,66 71

8 1,78 78

9 1,73 77

10 1,59 69
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Fachbereich Wirtschaftswissenschaften

Ist ein Zusammenhang grafisch plausibel?

Sommersemester 2017

Christian Reinboth, Dipl.-Wi.Inf.(FH)

> Plot > XY graph
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Berechnung von Korrelationskoeffizienten
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> Univariate > Correlation

Was ist hier was?

Kendall‘s tau = 

Konkordanzkoeffizient nach Kendall

Linear r (Pearson) = 

Bravais-Pearson-Korrelationskoeffizient

Spearman‘s rs = 

Rangkorrelationskoeffizient nach Spearman

Interpretation des Betrags von x

x = 0 = keine Korrelation

0 < x < 0,5 = schwache Korrelation

0,5 <= x < 0,8 = mittlere Korrelation

0,8 <= x < 1 = starke Korrelation

x = 1 = perfekte Korrelation
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Korrelation ist nicht gleich Kausalität

– Eine über einen Korrelationskoeffizienten identifizierte Korrelation sollte

näher untersucht, dabei jedoch niemals inhaltlich interpretiert werden

– Grund dafür ist, dass eine Korrelation nicht notwendigerweise auf einem

Ursache-Wirkungs-Zusammenhang beruht – auch wenn es in vielen 

Fällen leider äußerst verführerisch ist, diese Annahme zu treffen

– Tatsächlich kann es verschiedene Erklärungen für Korrelationen geben

– Einseitiger Zusammenhang: X beeinflusst Y bzw. Y beeinflusst X

– Beidseitiger Zusammenhang: X und Y beeinflussen sich gegenseitig

– Es handelt sich um einen reinen Zufallseffekt in den Daten (Scheinkorrelation)

– Eine dritte Variable (Z) beeinflusst X und Y gleichermaßen (Scheinkorrelation)

– Ein klassisches Beispiel für eine Scheinkorrelation ist die Korrelation zwischen

Storchenzahl und Geburtenquote (verbunden über die Variable „Urbanisierung“)
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Wo befinden wir uns?
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deskriptiv explorativ

induktiv

Statistik

LagemaßeStreuungsmaße

Ausreißersuche

B-P-K

T-Test

Chi²-Test

K-S-A

Kendall

Spearman

Tabellen
Box-Plot

Histogramm

Streudiagramm

Regression

Ausreißeranalyse
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Erstellung eines Box-Plots
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> Plot > Barchart/Boxplot

Damit der Box-Plot so formatiert ist, wie wir es 

aus der Vorlesung kennen, sind noch mehrere 

Anpassungen nötig, u.a.:

> Plot type > Box plot

> Quartile method > interpolation

> Graph settings (u.a. Colors, Axes…)
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Erstellung vergleichender Box-Plots
(nach Erweiterung des Datensatzes)
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Erstellung vergleichender Box-Plots
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> Plot > Barchart/Boxplot
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Wo befinden wir uns?
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deskriptiv explorativ

induktiv

Statistik

LagemaßeStreuungsmaße

Ausreißersuche

B-P-K

T-Test

Chi²-Test

K-S-A

Kendall

Spearman

Tabellen
Box-Plot

Histogramm

Streudiagramm

Regression

Ausreißeranalyse



Seite 26

Fachbereich Wirtschaftswissenschaften

Beispieldatensatz zur linearen Regression
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Nr. x y

1 12 10000

2 15 15000

3 8 6000

4 11 11000

5 3 5000

6 17 23000

7 24 37000

Beispielfall mit bewusst gering gehaltener

(Foliendarstellung…) Anzahl von Werten: 

 x = Prozentualer Anteil des Werbebudgets 

eines Produkts am Gesamtbudget der Firma

 y = Verkaufte Einheiten des betrachteten

Produkts in einem Untersuchungszeitraum

 Annahme: Das betrachtete Produkt, 

der Untersuchungszeitraum sowie 

das Gesamtbudget bleiben gleich 

(ceteris paribus)

Wie lautet die Regressionsgleichung?
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Ist ein Zusammenhang grafisch plausibel?
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> Plot > XY graph
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Erstellung und Bewertung des LR-Modells
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> Model > Linear > Bivariate

y = -5.234,2 + 1.596 * x 

Was ist hier was? Slope = Steigung (Regressionskoeffizient)

Intercept = Schnittpunkt mit der y-Achse

r² = Bestimmtheitsmaß / Gütekriterium
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Sichtbarmachung des Leverage-Effekts
(Was eine kleine Änderung bewirken kann…)
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Sichtbarmachung des Leverage-Effekts
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> Model > Linear > Bivariate
Wie deutlich verschlechtert sich hier r²? 
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Was kann andere (freie) Software (besser)?
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Erstellung von Box-Plots mit SSP
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> Describing Data > Median, Quartiles > Box-Plot 

Schöne Übersicht der Konstruktionsgrößen – weniger ansehnlicher Box-Plot
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Erstellung „schöner“ Grafiken mit SOFA

Sommersemester 2017

Christian Reinboth, Dipl.-Wi.Inf.(FH)

> Diagramme > Balkendiagramm erstellen
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Erstellung „schöner“ Grafiken mit SOFA
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> Diagramme > Scatterplot erstellen
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Detailergebnisse der Regression in PSPP
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> Analysieren > Regression > Linear

Tipp: PSPP eignet sich 

für die Vorbereitung der 

Statistik II-Klausur in 

besonderer Weise
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Kleine Vorschau auf Statistik II
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Simulation von Münzwürfen in SSP
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> Uncertainty > Coin Flip Simulation

Gesetz der Großen Zahlen: Die relative Häufigkeit eines Zufallsergebnisses stabilisiert sich um 

die theoretische Wahrscheinlichkeit eines Zufallsergebnisses, wenn das zu Grunde liegende 

Zufallsexperiment immer wieder unter denselben Voraussetzungen durchgeführt wird. 
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Simulation von Würfelwürfen in SSP
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> Uncertainty > Dice Roll Simulation

Gesetz der Großen Zahlen: Die relative Häufigkeit eines Zufallsergebnisses stabilisiert sich um 

die theoretische Wahrscheinlichkeit eines Zufallsergebnisses, wenn das zu Grunde liegende 

Zufallsexperiment immer wieder unter denselben Voraussetzungen durchgeführt wird. 
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Simulation eines Galtonbretts in SSP
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Foto: Klaus-Dieter Keller; Lizenz: gemeinfrei; Quelle: Wikimedia

> Uncertainty > Galton‘s Apparatus

Mit Hilfe eines Galtonbretts lässt sich visuell 

demonstrieren, warum viele Zufallsvariablen 

der Bionomialverteilung folgen.
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Bestimmung der optimalen Stichprobengröße
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 Was passiert bei....

 größerer Grundgesamtheit?

 kleinerer Grundgesamtheit?

 bekannten Anteilswerten?

 weniger Sicherheit?

 mehr Sicherheit?

Kostenloser Download unter: 

http://www.statistikberatung.eu/

SampleSizer.zip
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Vielen Dank für die
Aufmerksamkeit!

Einführung in freie statistische Software
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Christian Reinboth

Telefon +49 3943 –  896

Telefax +49 3943 –  5896

E-Mail creinboth@hs-harz.de

Friedrichstraße 57 –  59 

38855 Wernigerode
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